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Preface

Audience and Use
The User Workstation Setup Guide for Cisco Unity Connection contains information and instructions 
that system administrators can use for setting up user workstation access to Cisco Unity Connection web 
tools, for configuring email accounts to access Connection voice messages, and for conducting 
orientation sessions for users.

Documentation Conventions

The User Workstation Setup Guide for Cisco Unity Connection also uses the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Table 1 Conventions in the User Workstation Setup Guide for Cisco Unity Connection 

Convention Description

boldfaced text Boldfaced text is used for:

 • Key and button names. (Example: Click OK.)

 • Information that you enter. (Example: Enter Administrator 
in the User Name box.)

< >

(angle brackets)

Angle brackets are used around parameters for which you supply 
a value. (Example: In your browser, go to https://<Cisco Unity 
Connection server IP address>/cuadmin.)

- 

(hyphen)

Hyphens separate keys that must be pressed simultaneously. 
(Example: Press Ctrl-Alt-Delete.)

> 

(right angle bracket)

A right angle bracket is used to separate selections that you make 
in the navigation bar of Cisco Unity Connection Administration. 
(Example: In Cisco Unity Connection Administration, expand 
Contacts > System Contacts.)
v
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Preface
  
Tip Means the following information may help you solve a problem.

Caution Means reader be careful. In this situation, you might do something that could result in equipment damage 
or loss of data.

Cisco Unity Connection Documentation
For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, see the 
Documentation Guide for Cisco Unity Connection. The document is shipped with Connection and is 
available at http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/roadmap/7xcucdg.html.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS version 2.0. 

Cisco Product Security Overview
This product contains cryptographic features and is subject to United States and local country laws 
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply 
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors 
and users are responsible for compliance with U.S. and local country laws. By using this product you 
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local 
laws, return this product immediately.

Further information regarding U.S. export regulations can be found at 
http://www.access.gpo.gov/bis/ear/ear_data.html.
vi
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Setting Up Access to the Cisco Personal 
Communications Assistant

The Cisco Personal Communications Assistant (PCA) is installed on the Cisco Unity Connection server 
during installation. It is a website that provides users with access to the Cisco Unity web tools, which 
allow users to manage messages and personal preferences in Connection. The web tools available in the 
Cisco PCA include:

 • Cisco Unity Assistant

 • Cisco Unity Inbox

 • Cisco Unity Personal Call Transfer Rules

To learn more about the tools listed above, see the applicable User Guide for Cisco Unity Connection 
and the Help for each tool.

See the following sections:

 • Configuring an Internet Browser to Access the Cisco PCA, page 1-1

 • Changing the GUI Language for the Cisco PCA, page 1-3

 • Customizing the Cisco Unity Inbox for a Low-Bandwidth Deployment, page 1-3

 • Managing Security Alerts When Using Self-Signed Certificates with SSL Connections, page 1-4

Configuring an Internet Browser to Access the Cisco PCA
The browsers on each user workstation must be set up to use the Cisco PCA and the Cisco Unity web 
tools. See the applicable section, depending on the browser installed on the computer:

 • Apple Safari, page 1-2

 • Microsoft Internet Explorer, page 1-2

 • Mozilla Firefox, page 1-2

(For the list of versions supported for each browser, see the Compatibility Matrix: Cisco Unity 
Connection and the Software on User Workstations, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucclientmtx.html
.)
1-1
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Chapter 1      Setting Up Access to the Cisco Personal Communications Assistant
  Configuring an Internet Browser to Access the Cisco PCA
Apple Safari
Do the following tasks to set up Safari for accessing the Cisco PCA.

1. Confirm that the software required for correct browser configuration is installed. See the “Software 
Requirements—User Workstations” section of the System Requirements for Cisco Unity Connection 
Release 7.x, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.html
.

2. Configure Safari:

a. Enable Java.

b. Enable Java Script.

c. Accept cookies only from sites that you navigate to.

Microsoft Internet Explorer
Do the following tasks to set up Internet Explorer for accessing the Cisco PCA.

1. Confirm that the software required for correct browser configuration is installed. See the “Software 
Requirements—User Workstations” section of the System Requirements for Cisco Unity Connection 
Release 7.x, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.html
.

2. Configure Internet Explorer:

a. Enable Active scripting.

b. Download and run ActiveX controls.

c. Enable Java scripting.

d. Accept all cookies.

e. Automatically check for newer versions of temporary Internet files.

f. Enable Medium-High privacy.

Mozilla Firefox
Do the following tasks to set up Firefox for accessing the Cisco PCA.

1. Confirm that the software required for correct browser configuration is installed. See the “Software 
Requirements—User Workstations” section of the System Requirements for Cisco Unity Connection 
Release 7.x, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.html
.

2. If users are running Firefox on Apple MAC OS X or Microsoft Windows workstations, skip to 
Task 3.
1-2
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Chapter 1      Setting Up Access to the Cisco Personal Communications Assistant
  Changing the GUI Language for the Cisco PCA
If users are running Firefox on Linux Red Hat workstations, confirm that they are using the correct 
sound card by referring to the sound card support matrix on the Alsa-project.org website. (Note that 
the Java Runtime Environment (JRE) plug-in software uses the Advanced Linux Sound Architecture 
(ALSA) driver to access system sound devices and to control playback and recording functionality. 
Depending on the sound card, playback and recording capabilities may be limited.)

3. Configure Firefox:

a. Enable Java.

b. Enable Java Script > Enable Change Images in Java Script Advanced.

c. Allow sites to set cookies. (For security purposes, we recommend that you set this to Allow 
Sites to Set Cookies for the Originating Web Site Only.)

Changing the GUI Language for the Cisco PCA
Revised May 2009
Do the following tasks to change the GUI language that is used in the Cisco PCA.

1. Download and install the applicable languages. For instructions, see the “Downloading and 
Installing Cisco Unity Connection Languages” section of the applicable Release Notes for 
Cisco Unity Connection, at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

2. On the user workstation, select a language in the Internet browser. The language selected in the 
browser must be one of the languages that the Cisco PCA offers and it must be installed on the 
Connection server. For a list of supported languages, see the “Available Languages for Cisco Unity 
Connection Components” section of the applicable System Requirements document:

 • System Requirements for Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.
html

 • System Requirements for Cisco Unity Connection in Cisco Unified CMBE Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucmbesysr
eqs.html

Customizing the Cisco Unity Inbox for a Low-Bandwidth 
Deployment

If users play recordings by using computer speakers in a low-bandwidth deployment (for example, with 
a slow modem or in a branch office), they should download messages before playing them for best 
performance and quality.

To customize the Cisco Unity Inbox so that messages are downloaded rather than streamed from the 
Cisco Unity Connection server during playback, do the following procedure to change the Performance 
setting on each user workstation (as applicable).

To Customize the Cisco Unity Inbox to Download Messages Before Playing Them

Step 1 On the Cisco PCA Home page, click the Cisco Unity Inbox link.
1-3
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Chapter 1      Setting Up Access to the Cisco Personal Communications Assistant
  Managing Security Alerts When Using Self-Signed Certificates with SSL Connections
Step 2 In the Cisco Unity Inbox, go to a page that contains the Media Master. (For example, click the New 
Message icon to open a new message window.)

Step 3 On the Media Master Options menu, click Playback & Recording.

Step 4 In the Playback and Recording Settings dialog box, under Performance, click Download Complete 
Message Before Playing.

Step 5 Click OK.

Managing Security Alerts When Using Self-Signed Certificates 
with SSL Connections

If you use the self-signed certificate generated during installation to provide an SSL connection to the 
Cisco PCA, the web browser of the user displays a message to alert the user that the authenticity of the 
site cannot be verified, and therefore its content cannot be trusted. Similarly, if you use a self-signed SSL 
certificate to secure IMAP email client access to Connection, some email clients supported for use with 
Connection display SSL security messages.

Although users can still access Connection despite the alerts, consider one of the following options to 
manage or eliminate security alerts when users browse to Cisco PCA and/or access their messages from 
an IMAP email client:

 • Add the SSL certificate to the Trusted Root Store on each user workstation. In this way, you can 
ensure that users never see the security alert. See the following “To Add the SSL Certificate to the 
Trusted Root Store on User Workstations” procedure.

 • Tell users to choose the “Accept Permanently” (or similar) option when the browser or email client 
displays the alert and asks them how to proceed. After instructing the browser and/or email client to 
always accept the certificate, the user will not see the alert again.

Do the following procedure if you want users to never see the security alert.

To Add the SSL Certificate to the Trusted Root Store on User Workstations

Step 1 From the OS Administration application on the Cisco Unity Connection server, right-click to download 
the certificate and save it as a file.

Step 2 Copy the certificate to each user workstation, and then import it by using tools in the browser or IMAP 
client, as applicable.
1-4
User Workstation Setup Guide for Cisco Unity Connection Release 7.x

OL-17019-01



User Workstation 
OL-17019-01
C H A P T E R 2

Setting Up Playback and Recording Devices for 
the Media Master

The Media Master is used to make and play recordings in the Cisco Unity Connection web tools.

See the following sections:

 • About the Media Master, page 2-1

 • Determining Which Recording and Playback Devices Users Will Use for the Media Master, page 2-2

 • How Users Specify Their Recording and Playback Device Preferences, page 2-3

About the Media Master
The Media Master appears on the pages of the Cisco Unity Inbox and Cisco Unity Personal Call Transfer 
Rules web tools on which users can make or play recordings. Depending on how Cisco Unity Connection 
is set up, the Media Master may also appear on some Cisco Unity Assistant pages. Users can use the 
phone or the computer microphone and speakers with the Media Master controls to make and play 
recordings. See Figure 2-1.

Figure 2-1 Media Master
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Chapter 2      Setting Up Playback and Recording Devices for the Media Master
  Determining Which Recording and Playback Devices Users Will Use for the Media Master
The Media Master is a Java 2 Platform, Standard Edition (J2SE) application, and the Java plug-in 
component must be installed on the user workstation for it to run properly.

Note Depending on the Internet browser, if the Java plug-in component is not installed, the Media Master does 
not appear in the browser window or the user is prompted to install the component. (See the “Configuring 
an Internet Browser to Access the Cisco PCA” section on page 1-1.)

Before users start using the Cisco Unity Connection web tools that offer the Media Master, specify that 
Connection has at least one voice messaging port designated to allow users to use the phone as a 
recording and playback device, by adjusting the Allow TRAP Connections setting on the Telephony 
Integrations > Port page in Cisco Unity Connection Administration. See the “Changing Port Settings” 
section in the “Managing the Phone System Integrations” chapter of the System Administration Guide 
for Cisco Unity Connection for instructions. Alternatively, provide sound cards, earphones or speakers, 
and microphones to users who do not want to use the phone as their recording and playback device.

Determining Which Recording and Playback Devices Users 
Will Use for the Media Master

When determining the recording and playback devices that you want users to use, note the following 
considerations:

 • The phone offers the best sound quality for recordings, and serves as the default recording and 
playback device for the Media Master.

 • In order for users to use the phone as a recording and playback device, Cisco Unity Connection must 
have at least one voice messaging port designated for this purpose. Note that when a user listens to 
messages or other recordings by using a computer microphone and speakers, no ports are used, 
which decreases the load on the Connection server and leaves ports open for other functions.

 • You must provide sound cards, speakers, and microphones to users who do not want to use the phone 
as their recording and playback device.

See the following sections for detailed descriptions of the events that occur when using the phone or the 
computer microphone and speakers for recording and playback:

 • What Happens When the Phone Is Used as the Recording and Playback Device, page 2-3

 • What Happens When a Computer Microphone and Speakers Are Used as the Recording and 
Playback Devices, page 2-3

1 Options menu 7 Stop

2 Recording/playback progress 8 Pause

3 Record list 9 Play

4 Help menu 10 Volume control

5 Playback speed control 11 Playback list

6 Record   
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Chapter 2      Setting Up Playback and Recording Devices for the Media Master
  How Users Specify Their Recording and Playback Device Preferences
What Happens When the Phone Is Used as the Recording and Playback Device
When users use the phone as a recording and playback device in the web tools that are accessed through 
the Cisco PCA (and in Cisco Unity Connection Administration), the following events occur:

1. The user clicks the applicable option in the client application to make or play a recording.

2. The client application asks Cisco Unity Connection to place a call to the user extension, and 
Connection calls the extension.

3. When making a recording, the user answers the phone, and begins recording the message, name, or 
greeting. When the user hangs up, the client application tells Connection that the recording is 
finished.

4. When playing a recording, the user answers the phone, and the client application asks Connection 
to play the message. Connection streams the recording by phone.

What Happens When a Computer Microphone and Speakers Are Used as the 
Recording and Playback Devices

When users use a computer microphone and speakers as the recording and playback devices, the 
following events occur:

1. The user clicks the applicable option in the client application to make or play a recording.

2. When making a recording, the user begins speaking into the microphone. When the user clicks the 
applicable option in the client application to stop recording, the client application tells Cisco Unity 
Connection that the recording is finished.

3. When playing a recording, Connection streams the message to the client application. Streaming 
occurs on demand, regardless of network traffic. The client application begins to play the message 
through the speakers as soon as a few seconds of the message are buffered in memory on the user 
workstation.

How Users Specify Their Recording and Playback Device 
Preferences

Users can set their own recording and playback device preferences. For example, the Options menu in 
the Media Master allows users to choose their own recording and playback devices.

Media Master recording and playback settings are saved per user, per workstation. This means that:

 • A user can change recording and playback devices from the Options menu and from both the 
Playback and Record lists of any Media Master on the web-tool pages. The recording and playback 
devices that a user chooses apply to all Cisco Unity Connection web tools, as long as the user 
accesses the applications from the same workstation on which the changes were initially made.

 • If multiple users share the same workstation, each user who uses the workstation must indicate a 
choice of recording and playback devices.

 • If a user has updated the choice of recording and playback devices from one workstation but also 
accesses the web tools on a different workstation (for example, from a computer at home), the choice 
of recording and playback devices must be set for the second workstation as well.
2-3
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  How Users Specify Their Recording and Playback Device Preferences
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C H A P T E R 3

Configuring an Email Account to Access 
Cisco Unity Connection Voice Messages

Cisco Unity Connection allows licensed users to use a third-party IMAP client to access voice messages 
from their desktop machines. You can also forward voice messages with text and reply to voice messages 
with text; the text portion of the message is accessible through the Connection Text to Speech feature.

See the following sections:

 • Considerations When Configuring IMAP Email Clients, page 3-1

 • Creating and Configuring an Account in Apple Mail, page 3-2

 • Creating and Configuring an Account in Eudora, page 3-3

 • Creating and Configuring an Account in IBM Lotus Notes, page 3-5

 • Creating and Configuring an Account in Microsoft Outlook, page 3-6

 • Setting Up Cisco Unity Connection ViewMail for Microsoft Outlook, page 3-8

 • Creating and Configuring an Account in Microsoft Outlook Express, page 3-11

 • Creating and Configuring an Account in Novell GroupWise, page 3-12

 • Creating and Configuring an Account in Opera, page 3-14

 • Creating and Configuring an Account in Thunderbird, page 3-15

 • Creating and Configuring an Account in Windows Mail for Windows Vista, page 3-16

 • Troubleshooting IMAP Client Logon Problems, page 3-17

Note When users change their Cisco Personal Communications Assistant (PCA) password in the Cisco Unity 
Assistant, they also must update the password from their IMAP client application. Passwords are not 
synchronized between IMAP clients and the Cisco PCA. If users have trouble receiving voice messages 
in an IMAP client even after updating their Cisco PCA password in both applications, see the 
“Troubleshooting IMAP Client Logon Problems” section on page 3-17.

Considerations When Configuring IMAP Email Clients
Revised May 2009
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Chapter 3      Configuring an Email Account to Access Cisco Unity Connection Voice Messages
  Creating and Configuring an Account in Apple Mail
Note the following considerations when configuring IMAP email clients to access Cisco Unity 
Connection voice messages:

 • In Cisco Unity Connection Administration, configure the following settings on the System 
Settings > SMTP Configuration > Server page to match the SSL settings in the IMAP email clients:

 – Allow Connections From Untrusted IP Addresses

 – Require Authentication From Untrusted IP Addresses

 – Transport Layer Security From Untrusted IP Addresses Is (Disabled, Required, Optional)

For more information on these settings, see the “SMTP Server Configuration” section in the 
“System Settings” chapter of the Interface Reference Guide for Cisco Unity Connection 
Administration.

 • IMAP email clients all include two fields in which you can enter either the IP address or the fully 
qualified domain name of the Connection server. When clustering is configured, enter the fully 
qualified domain name of a DNS A record that includes the Connection publisher and subscriber 
servers. If your DNS server allows you to specify the order in which DNS tries to contact Connection 
servers, specify that the server that is available most often is the first server contacted. This usually 
is the publisher server.

Some IMAP email clients do not respect DNS A records. For those clients, if the first Connection 
server is not available, the client does not try to access the other Connection server.

 • When a user forwards or replies to a voice message from an IMAP email client, the message will be 
sent to recipients on the Connection server unless the user specifically configures the message to be 
sent through another account.

See the “Configuring IMAP Settings” chapter of the System Administration Guide for Cisco Unity 
Connection for additional details.

Creating and Configuring an Account in Apple Mail
To use Apple Mail to access Cisco Unity Connection voice messages, create and configure a new Apple 
Mail account for the user. You need the following information:

 • Connection user name (alias).

 • Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Apple Mail

Step 1 Start Apple Mail.

Step 2 In Apple Mail, on the Mail menu, click Preferences.

Step 3 At the top of the Preferences dialog box, click Accounts.

Step 4 In the lower left corner, click +.

Step 5 In the Account Type list, click IMAP.

Step 6 In the Description field, enter a name for the account. This name appears only in Apple Mail.
3-2
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Chapter 3      Configuring an Email Account to Access Cisco Unity Connection Voice Messages
  Creating and Configuring an Account in Eudora
Step 7 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 In the Full Name field, enter the user name.

Step 9 In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 10 In the User Name field, enter the Connection user name.

Step 11 In the Password field, enter the Cisco PCA password.

Step 12 In the Outgoing Mail Server (SMTP) field, click the IP address or the fully qualified domain name of the 
Connection server.

Step 13 Click Server Settings.

Step 14 Optionally, in the SMTP Server Options dialog box, check the Use Secure Sockets Layer (SSL) check 
box.

Caution If you do not configure Apple Mail to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
are not encrypted.

Step 15 In the Authentication list, click Password.

Step 16 Click OK to close the SMTP Options dialog box.

Step 17 Click the Advanced tab.

Step 18 In the Keep Copies of Messages for Offline Viewing list, choose the applicable option.

Step 19 Close the Preferences dialog box.

Step 20 In the Save Changes dialog box, click Save.

Creating and Configuring an Account in Eudora
To use Eudora to access Cisco Unity Connection voice messages, create and configure a new Eudora 
account for the user. You need the following information:

 • Connection user name (alias).

 • Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.
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To Create and Configure a New Account in Eudora

Step 1 Start Eudora.

Step 2 On the Eudora Tools menu, click Personalities.

Step 3 Right-click anywhere in the Personalities tab, and click New.

Step 4 In the New Account wizard, on the Account Settings page, click Next to accept the default value, Create 
a Brand New E-Mail Account.

Step 5 On the Personality Name page, enter a display name for the account. The value that you enter here is 
visible only in Eudora.

Step 6 Click Next.

Step 7 On the Personal Information page, enter the user name.

Step 8 Click Next.

Step 9 On the E-Mail Address page, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 10 Click Next.

Step 11 On the User Name page, enter the Connection user name.

Step 12 Click Next.

Step 13 On the Incoming E-Mail Server page, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 14 For the type of server, click IMAP.

Step 15 Click Next.

Step 16 On the IMAP Location Prefix page, do not enter a value.

Step 17 Click Next.

Step 18 On the Outgoing E-Mail Server page, enter the IP address or the fully qualified domain name of the 
Connection server.

Step 19 Click Next.

Step 20 On the Success page, click Finish to create the account and close the wizard.

Step 21 In the Enter Password dialog box, enter the Cisco PCA password of the user.

Step 22 Click OK.

Step 23 Optionally, configure the new account to use SSL. For more information, see Eudora Help.
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Caution If you do not configure Eudora to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection are 
not encrypted.

Creating and Configuring an Account in IBM Lotus Notes
Revised May 2009

Caution If you plan to configure user accounts to use Cisco Unity Connection ViewMail for IBM Lotus Notes, 
do not follow the instructions in this section. Instead, follow the configuration instructions in the Release 
Note for Cisco Unity Connection ViewMail for IBM Lotus Notes, available at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

To use Notes to access Cisco Unity Connection voice messages, create and configure a new Notes 
account for the user. You need the following information:

 • Connection user name (alias).

 • Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

Caution When using Lotus Notes version 7.x to access Connection voice messages, you must first configure 
Notes to connect to a Domino account before configuring the Connection account.

To Create and Configure a New Account in IBM Lotus Notes

Step 1 Start IBM Lotus Notes.

Step 2 On the Notes File menu, click Preferences > Client Reconfiguration Wizard.

Step 3 In the Lotus Notes Client Configuration wizard, on the Additional Services page, check the Internet 
Mail Servers (POP or IMAP, SMTP) check box.

Step 4 Click Next.

Step 5 On the Set Up Internet Mail page, in the Select the Type of Server Used for Retrieving Incoming Mail 
list, click IMAP.

Step 6 In the Enter a New Account Name list, click Incoming Internet Mail.

Step 7 In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the 
Cisco Unity Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 8 Click Next.
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Step 9 On the Set Up Internet Mail page, in the Account Name field, enter the Connection SMTP Address of 
the user and the name of the Connection server. You can find this information in the SMTP Address field 
on the User Basics page in Cisco Unity Connection Administration. The Account Name typically 
follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 10 In the Password fields, enter and confirm the Cisco PCA password of the user.

Step 11 If you want to encrypt voice messages and other data that are sent between Notes and Connection, check 
the Log On Using SSL check box. If not, skip to Step 12.

Caution If you do not configure Notes to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages that are sent back from 
Connection are not encrypted.

Step 12 Click Next.

Step 13 On the second Set Up Internet Mail page, in the Enter a New Account Name list, click Outgoing 
Internet Mail.

Step 14 In the Outgoing SMTP Mail Server list, enter the IP address or the fully qualified domain name of the 
Connection server.

Step 15 Click Next.

Step 16 On the third Set Up Internet Mail page, in the E-Mail Address field, enter the Connection alias of the 
user and the name of the Connection server. Use the following format:

<alias>@<fully qualified domain name of the Connection server>

Step 17 In the Internet Domain field, enter the Internet domain name of the Domino mail server.

Step 18 Click Next.

Step 19 Click OK.

Creating and Configuring an Account in Microsoft Outlook
Revised May 2009
To use Outlook to access Cisco Unity Connection voice messages, create and configure a new Outlook 
account for the user. You need the following information:

 • Connection user name (alias).

 • Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

In addition to configuring Outlook to access Connection voice messages, you can also install the optional 
Cisco Unity Connection ViewMail for Microsoft Outlook plug-in. See the “Setting Up Cisco Unity 
Connection ViewMail for Microsoft Outlook” section on page 3-8.

To Create and Configure a New Account in Outlook

Step 1 Start Outlook.
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Step 2 On the Outlook Tools menu, click E-Mail Accounts.

Step 3 In the E-Mail Accounts wizard, click Add a New E-Mail Account.

Step 4 Click Next.

Step 5 On the Server Type page, click IMAP.

Step 6 Click Next.

Step 7 Enter values in the User Information section:

a. In the Your Name field, enter a display name for the account. The value that you enter here is visible 
only in Outlook.

b. In the E-Mail Address field, enter one of the following:

 • The Connection SMTP Address of the user and the name of the Connection server. You can find 
this information in the SMTP Address field on the User Basics page in Cisco Unity Connection 
Administration. The E-Mail Address typically follows this format:

<alias>@<SMTP domain name of the Connection server or cluster>

 • The proxy address for the user.

Step 8 Enter values in the Server Information Section:

a. In the Incoming Server field, enter the IP address or the fully qualified domain name of the 
Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

b. In the Outgoing Server field, click the IP address or the fully qualified domain name of the 
Connection server.

Step 9 Enter values in the Logon Information section:

a. In the User Name field, enter the Connection user name.

b. In the Password field, enter the Cisco PCA password of the user.

c. Verify that the Remember Password check box is not checked. If this option is checked, and the 
Connection password of the user expires, changes, or is locked, Microsoft Outlook does not prompt 
the user to enter the Connection password. The result is that users do not receive voice messages 
from Connection.

Step 10 If you do not want to encrypt voice messages and other data that are sent over the network between 
Outlook and Connection, skip to Step 15.

Caution If you do not configure Outlook to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection are 
not encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook and Connection, 
continue with Step 11.

Step 11 Click More Settings.

Step 12 In the Internet E-Mail Settings dialog box, click the Advanced tab.
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Step 13 Under Incoming Server (IMAP), check the This Server Requires an Encrypted Connection (SSL) 
check box.

Step 14 Click OK to close the Internet E-Mail Settings dialog box.

Step 15 If the Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to 
Step 21.

If the Connection SMTP server is configured to require authentication from untrusted IP addresses, 
continue with Step 16.

Step 16 Click More Settings.

Step 17 In the Internet E-Mail Settings dialog box, click the Outgoing Server tab.

Step 18 Verify that the My Outgoing Server (STMP) Requires Authentication check box is checked.

Step 19 Verify that Use Same Settings as My Incoming Mail is selected.

Step 20 Click OK to close the Internet E-Mail Settings dialog box.

Step 21 Click Next.

Step 22 Click Finish.

Step 23 In the left pane of Outlook, click the Inbox folder for the new account.

Step 24 On the Outlook Tools menu, click Send/Receive > This Folder.

Step 25 If prompted, enter the Connection user name and Cisco PCA password.

Setting Up Cisco Unity Connection ViewMail for Microsoft 
Outlook

By using ViewMail for Outlook to access Cisco Unity Connection voice messages, users can play and 
record voice messages by using the Media Master. See Figure 3-1.

Figure 3-1 Media Master
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Task List for Setting Up ViewMail for Outlook
ViewMail must be installed on each user workstation. Complete the following tasks to set up ViewMail 
for users:

1. Review the applicable Release Notes for Cisco Unity Connection ViewMail for Microsoft Outlook, 
available at http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html. The 
document specifies the requirements and procedures for installing ViewMail.

2. If you have not already done so, install ViewMail according to the procedures in the Release Notes 
for Cisco Unity Connection ViewMail for Microsoft Outlook.

3. If you have not already done so, configure an IMAP account in Microsoft Outlook. See the “Creating 
and Configuring an Account in Microsoft Outlook” section on page 3-6.

4. If users have more then one IMAP account configured, you must configure ViewMail to use the 
IMAP account that is used to access Connection. See the “Configuring the IMAP Account for 
ViewMail for Outlook” section on page 3-9.

5. If you use secure messaging or TRAP, you must configure several ViewMail settings. See the 
“Configuring ViewMail for Outlook Settings for Secure Messaging and TRAP” section on page 3-9.

Configuring the IMAP Account for ViewMail for Outlook
Revised May 2009
If users have more than one IMAP account configured, you must configure ViewMail to use the IMAP 
account that is used to access Connection. This ensures that messages composed by using ViewMail are 
sent to the Connection server. If users have only one IMAP account configured, ViewMail automatically 
uses it to send messages to Connection.

Do the following procedure on each user workstation.

To Configure ViewMail for Outlook Settings

Step 1 From the Outlook Tools menu, click ViewMail Options.

Step 2 Click the Accounts tab.

Step 3 In the Select the Account to Access Cisco Unity Connection With field, select the IMAP account that is 
used to access Connection.

Step 4 Click Save.

Configuring ViewMail for Outlook Settings for Secure Messaging and TRAP
If you have configured Connection for secure messaging or if you want users to be able to record or play 
messages by phone by using Telephone Record and Playback (TRAP), you must configure several 
ViewMail settings.

After ViewMail has been installed, do the following procedure on each user workstation.
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To Configure ViewMail for Outlook Secure Message and TRAP Settings

Step 1 From the Outlook Tools menu, click ViewMail Options.

Step 2 Click the Server tab.

Step 3 Enter the following settings:

Step 4 Click Save.

Table 3-1 Server Settings 

Field Setting

Cisco Unity Connection 
Server Name

Enter the name of the Connection server. (Required for secure messaging 
and TRAP.)

Username Enter the Connection user name (alias).

Password (Optional) Enter the Cisco PCA password of the user. If you do not enter 
the password, the user is prompted for it each time Outlook is restarted. 
If you do not want the user to be prompted for the password each time 
Outlook is restarted, you must also check the Remember Password check 
box.

Remember Password (Optional) Check this check box if you want ViewMail to remember the 
user password so that the user does not have to re-enter it each time 
Outlook is restarted.

Proxy Server Address If you have a firewall that blocks HTTPS traffic between user 
workstations and the Connection server, enter the IP address of the 
HTTPS proxy server.

Proxy Server Port If you have a firewall that blocks HTTPS traffic between user 
workstations and the Connection server, enter the server port to use when 
connecting to the HTTPS proxy server.

Validate HTTPS Certificate If you replace the default self-signed certificate with a certificate from a 
certificate authority, check the Validate HTTPS Certificate check box.

If you are using the default certificate installed with Connection, this 
check box must not be checked.

For details, see the “Securing Cisco PCA and IMAP Email Client Access 
to Cisco Unity Connection” chapter of the System Administration Guide 
for Cisco Unity Connection.

Extension Enter the extension of the user.

This setting is required only if you want the user to be able to record or 
play messages by phone.
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Creating and Configuring an Account in Microsoft Outlook 
Express

To use Outlook Express to access Cisco Unity Connection voice messages, create and configure a new 
Outlook Express account for the user. You need the following information:

 • Connection user name (alias).

 • Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Outlook Express

Step 1 Start Outlook Express.

Step 2 On the Outlook Express Tools menu, click Accounts.

Step 3 In the Internet Accounts dialog box, click the Mail tab.

Step 4 Click Add > Mail, and the Internet Connection wizard appears.

Step 5 On the Your Name page, in the Display Name field, enter the user name.

Step 6 Click Next.

Step 7 On the Internet E-Mail Address page, click I Already Have an E-Mail Address That I'd Like to Use.

Step 8 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 9 Click Next.

Step 10 On the E-Mail Server Names page, in the My Incoming Mail Server Is a <protocol> Server list, click 
IMAP.

Step 11 In the Incoming Mail (POP3, IMAP, or HTTP) Server field, enter the IP address or the fully qualified 
domain name of the Connection server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 12 In the Outgoing Mail (SMTP) Server field, enter the IP address or the fully qualified domain name of 
the Connection server.

Step 13 Click Next.

Step 14 On the Internet Mail Logon page, in the Account Name and Password fields, enter the Connection user 
name and Cisco PCA password.

Step 15 Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked, 
Microsoft Outlook Express does not prompt the user to enter the Connection password. The result is that 
users do not receive voice messages from Connection.

Step 16 Click Next.
3-11
User Workstation Setup Guide for Cisco Unity Connection Release 7.x

OL-17019-01



Chapter 3      Configuring an Email Account to Access Cisco Unity Connection Voice Messages
  Creating and Configuring an Account in Novell GroupWise
Step 17 On the Congratulations page, click Finish.

Step 18 In the Internet Accounts dialog box, click the account that you created in Step 4, and click Properties.

Step 19 In the <account name> Properties dialog box, click the IMAP tab.

Step 20 Uncheck the Store Special Folders check box.

Step 21 In the Root Folder Path field, enter INBOX (all upper-case letters).

Step 22 If you do not want to encrypt voice messages and other data that are sent over the network between 
Outlook Express and Connection, skip to Step 25.

Caution If you do not configure Outlook Express to use SSL, the Connection user name and password 
that are sent to Connection over the network and the voice messages sent back from 
Connection are not encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook Express and 
Connection, continue with Step 23.

Step 23 Click the Advanced tab.

Step 24 Under Incoming Mail, check the This Server Requires a Secure Connection (SSL) check box.

Step 25 Click OK to close the <account name> Properties dialog box.

Step 26 Click Close to close the Internet Accounts dialog box.

Creating and Configuring an Account in Novell GroupWise
To use GroupWise to access Cisco Unity Connection voice messages, create and configure a new 
GroupWise account for the user. You need the following information:

 • Connection user name (alias).

 • Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in GroupWise

Step 1 Start GroupWise.

Step 2 On the GroupWise Tools menu, click Accounts > Account Options.

Step 3 In the Accounts dialog box, click Add.

Step 4 In the Create Account dialog box, in the Account Name field, enter a name for the account. This name 
appears only in GroupWise.

Step 5 In the Account Type list, click IMAP4.

Step 6 Click Next.

Step 7 In the Create Internet Account dialog box, in the Incoming Mail Server (IMAP4) field, enter the IP 
address or the fully qualified domain name of the Connection server.
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Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 8 In the Login Name field, enter the Connection user name.

Step 9 In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Step 10 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 11 In the From Name field, enter the user name.

Step 12 Click Next.

Step 13 Follow the on-screen prompts to complete the configuration.

Step 14 If you do not want to encrypt voice messages and other data that are sent over the network between 
GroupWise and Connection, skip to Step 20.

Caution If you do not configure GroupWise to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
are not encrypted.

If you want to encrypt voice messages and other data that are sent between GroupWise and Connection, 
continue with Step 15.

Step 15 In the Accounts dialog box, click the name of the account that you just created.

Step 16 Click Properties.

Step 17 Click the Advanced tab.

Step 18 Under Incoming Mail Server (IMAP4), check the Use SSL check box.

Step 19 Click OK to close the <Account Name> Properties dialog box.

Step 20 Click Close to close the Accounts dialog box.

Step 21 Create the inbox for the new account, and download Connection voice messages:

a. In the left pane of GroupWise, click the name of the new account.

b. In the Logon to <AccountName> dialog box, enter the PCA password for the user.

c. Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked, 
GroupWise does not prompt the user to enter the Connection password. The result is that users do 
not receive voice messages from Connection.

d. Click OK to close the Logon to <AccountName> dialog box.

e. With the name of the new account still selected in the left pane, on the GroupWise Tools menu, click 
Send/Receive > This Folder.
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Creating and Configuring an Account in Opera
To use Opera to access Cisco Unity Connection voice messages, create and configure a new Opera 
account for the user. You need the following information:

 • Connection user name (alias).

 • Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Opera

Step 1 Start Opera.

Step 2 On the Opera Tools menu, click Mail and Chat Accounts.

Step 3 In the Manage Accounts dialog box, click New.

Step 4 In the New Account wizard, click IMAP.

Step 5 Click Next.

Step 6 In the Real Name field, enter the account name.

Step 7 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 8 In the Organization field, enter the applicable value.

Step 9 Click Next.

Step 10 In the Login Name field, enter the Connection user name.

Step 11 In the Password field, enter the Cisco PCA password.

Step 12 Click Next. 

Step 13 In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 14 If you want to encrypt voice messages and other data that are sent between Opera and Connection, check 
the Use Secure Connection (TLS) check box. (TLS is an updated version of SSL.)

Caution If you do not configure Opera to use SSL, the Connection user name and password that are 
sent to Connection over the network and the voice messages sent back from Connection are 
not encrypted.

Step 15 In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Step 16 Click Finish.
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Step 17 Click OK to close the Subscribe IMAP Folders dialog box.

Step 18 Click OK to close the Manage Accounts dialog box.

Creating and Configuring an Account in Thunderbird
To use Thunderbird to access Cisco Unity Connection voice messages, create and configure a new 
Thunderbird account for the user. You need the following information:

 • Connection user name (alias).

 • Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Thunderbird

Step 1 Start Thunderbird.

Step 2 On the Thunderbird File menu, click New > Account.

Step 3 In the Account wizard, on the New Account Setup page, click E-Mail Account.

Step 4 Click Next.

Step 5 On the Identity page, in the Your Name field, enter the user name.

Step 6 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the 
Connection server. You can find this information in the SMTP Address field on the User Basics page in 
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 7 Click Next.

Step 8 On the Server Information page, under Select the Type of Incoming Server You Are Using, click IMAP.

Step 9 In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection 
server.

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured 
for the network.

Step 10 Click Next.

Step 11 On the User Names page, enter the Connection user name.

Step 12 Click Next.

Step 13 On the Account Name page, enter a name for the account. This name appears only in Thunderbird.

Step 14 Click Next.

Step 15 On the Congratulations page, confirm that the settings are correct, then click Finish.

Step 16 If you do not want to encrypt voice messages and other data that are sent over the network between 
Thunderbird and Connection, you are finished creating and configuring a new account. 
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If you want to encrypt voice messages and other data that are sent between Thunderbird and Connection, 
continue with Step 17.

Step 17 In the left pane of Thunderbird, click the name of the account that you just created.

Step 18 In the right pane of Thunderbird, under Accounts, click View Settings for This Account.

Step 19 In the Account Settings dialog box, under the account that you just created, click Server Settings.

Step 20 Under Server Settings, click the Use Secure Connection (SSL) check box.

Caution If you do not configure Thunderbird to use SSL, the Connection user name and password that 
are sent to Connection over the network and the voice messages sent back from Connection 
are not encrypted.

Step 21 Click OK to close the Account Settings dialog box.

Creating and Configuring an Account in Windows Mail for 
Windows Vista

Added May 2009
To use Windows Mail for Windows Vista to access Cisco Unity Connection voice messages, create and 
configure a new Windows Mail account for the user. You need the following information:

 • Connection user name (alias).

 • Cisco Personal Communications Assistant (PCA) password. (This is the web application password 
that is set on the User pages in Cisco Unity Connection Administration.)

 • The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Windows Mail

Step 1 Start Windows Mail.

Step 2 On the Tools menu, click Accounts.

Step 3 In the Internet Accounts dialog box, click Add.

Step 4 On the Select Account Type page, select E-Mail Account.

Step 5 Click Next.

Step 6 On the Your Name page, in the Display Name field, enter the user name.

Step 7 Click Next.

Step 8 On the Internet E-Mail Address page, in the E-Mail Address field, enter the Connection SMTP Address 
of the user and the name of the Connection server. You can find this information in the SMTP Address 
field on the User Basics page in Cisco Unity Connection Administration. The E-Mail Address typically 
follows this format:

<alias>@<fully qualified domain name of the Connection server>

Step 9 Click Next.

Step 10 On the Set Up E-Mail Servers page, under Incoming E-Mail Server Type, select IMAP.
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Step 11 In the Incoming Mail (POP3 or IMAP) Server field, enter the IP address or the fully qualified domain 
name of the Connection server.

Caution In Step 11 and Step 12, do not use the fully qualified domain name of the Connection server 
unless DNS is configured for the network.

Step 12 In the Outgoing E-Mail Server (SMTP) Name field, enter the IP address or the fully qualified domain 
name of the Connection server.

Step 13 If the Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to 
Step 15.

If the Connection SMTP server is configured to require authentication from untrusted IP addresses, 
continue with Step 14.

Step 14 Check the Outgoing Server Requires Authentication check box.

Step 15 Click Next.

Step 16 On the Internet Mail Logon page, enter the user Connection alias and Cisco PCA password.

Step 17 Click Next.

Step 18 On the Congratulations page, click Finish.

Step 19 Click Close to close the Internet Accounts dialog box.

Step 20 If you do not want to encrypt voice messages and other data that are sent over the network between 
Windows Mail and Connection, you are finished creating and configuring a new account.

If you want to encrypt voice messages and other data that are sent between Windows Mail and 
Connection, continue with Step 21.

Step 21 On the Tools menu, click Accounts.

Step 22 In the Internet Accounts dialog box, click the name of the mail account that you just created and click 
Properties.

Step 23 In the Properties dialog box, click the Advanced tab.

Step 24 Under both the Outgoing Mail field and the Incoming Mail field, check the This Server Requires a 
Secure Connection (SSL) check box.

Step 25 Click OK.

Caution If you do not configure Windows Mail to use SSL, the Connection username (alias) and 
password that are sent to Connection over the network and the voice messages sent back from 
Connection are not encrypted.

Step 26 Click Close to close the Internet Accounts dialog box.

Troubleshooting IMAP Client Logon Problems
When users change their Cisco PCA password in the Cisco Unity Assistant, they also must update the 
password from their IMAP client application so that the client can continue to access Connection and 
retrieve voice messages.
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If users have trouble receiving voice messages in an IMAP client, consider the following possibilities:

 • If the IMAP client application prompts a user for the Cisco PCA password, but does not accept it, 
the Cisco PCA password may have expired or changed, or is locked. Users can change their 
password in the Cisco Unity Assistant first and then update it from their IMAP client application.

 • If Microsoft Outlook users are not prompted for their Cisco PCA password, verify that the 
Remember Password check box on the Internet E-mail Settings (IMAP) page is not checked. If this 
option is checked, and the password of the user has expired, changed, or is locked, Microsoft 
Outlook does not prompt the user to enter the Cisco PCA password. The result is that the user does 
not receive voice messages from Connection, and Outlook prompts for the user name and password.
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User Orientation

See the following sections:

 • Orientation Task List, page 4-1

 • Settings That Users Can Change, page 4-3

Orientation Task List
Revised May 2009
After you set up the client applications that users will use to access Cisco Unity Connection from their 
phones and computers, use the following task list to acquaint users with Connection. If you are planning 
supplemental Connection training, also consider reviewing the potential user concerns and 
misconceptions listed in the “Support Desk Orientation” section on page 5-2.

Offer User Documentation and Contact Information

1. Give users a Cisco Unity Phone Menus and Shortcuts wallet card. Use the Wallet Card wizard to 
produce the card. The templates in the wizard list frequently used menu options and shortcuts for 
managing Connection messages and user preferences by phone; the wizard fills in the applicable 
keys based on the conversation that you specify. The resulting PDF is formatted as a wallet card that 
can be printed, then cut out and folded by users.

Procedures in the User Guide for the Cisco Unity Connection Phone Interface do not contain the 
keys that users press for Connection menu options. Instead, the procedures use the prompts that 
users hear to specify the menu options to choose. To provide users with key information, you must 
use the Wallet Card wizard.

The Wallet Card wizard also allows you to customize technical support information and instructions 
for logging on to Connection. The Wallet Card wizard is a Windows-based remote database 
administration tool. Download the tool and view Help at 
http://www.ciscounitytools.com/App_CUC_WalletCardWizard.htm.

2. Give each user applicable user guides. The following Cisco Unity Connection user guides are 
available at http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.

 – User Guide for the Cisco Unity Connection Phone Interface

 – User Guide for the Cisco Unity Connection Assistant Web Tool

 – User Guide for the Cisco Unity Connection Inbox Web Tool

 – User Guide for Accessing Cisco Unity Connection Voice Messages in an E-Mail Application

 – User Guide for the Cisco Unity Connection Personal Call Transfer Rules Web Tool
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Information in the guides is generally organized by feature. You can distribute the guides for the 
interfaces that users are using, or you can distribute feature-specific information to users for whom 
you have enabled the features. (On Cisco.com, click the link for the topics you want, and print the 
PDF files.)

3. Give users the phone numbers that they dial to access Connection from within your organization and 
from outside the organization. As applicable, show users which button or key to use on their desk 
phones to access Connection.

4. Give users the URL to the Cisco PCA website: http://<Cisco Unity Connection server 
name>/ciscopca.

5. Give users the name, extension, and/or email address of the Connection administrator and any 
support desk contact information.

6. Depending on the conversation version that users in your organization are familiar with, you may 
want to provide them with a list of phone menu differences between Connection and a former voice 
messaging system—especially if you choose not to offer them an alternative to the standard 
conversation, which is specified by default in the Voice Mail User template.

Provide Passwords and Security Guidelines

7. Provide users with their initial phone passwords. Alternatively, tell users to log on to the 
Cisco Personal Communications Assistant (PCA) website to set their phone passwords before they 
call Connection to complete first-time enrollment. (Users are not required to enter an existing phone 
password in order to change it in the Cisco PCA.)

If users choose not to initially change their password in the Cisco PCA, they are prompted to change 
their phone password during first-time enrollment.

8. Provide users with their initial Cisco PCA passwords. Users must use the Cisco Unity Assistant to 
change their Cisco PCA passwords.

9. Explain to users how to secure their phone and Cisco PCA passwords so that they adequately protect 
their Connection mailboxes from unauthorized access. Detail the security guidelines for your 
organization. Encourage users to enter secure passwords whenever they change their passwords.

10. Make sure users understand that their Cisco PCA passwords are not related to their Connection 
phone passwords, nor are the passwords synchronized. Users may assume that their phone and 
Cisco PCA passwords are the same. As a result, they may think that they are changing both 
passwords when the Connection conversation prompts them to change their phone password during 
first-time enrollment. For this reason, you may find that many users do not consider securing their 
Cisco PCA passwords, even though you request that they do so.

Remind Users to Complete First-Time Enrollment

11. Make sure that users know that they need to complete first-time enrollment by phone. They do not 
need to refer to any Connection documentation during enrollment. Connection indicates when the 
enrollment process is complete. If users hang up before they have completely enrolled, none of their 
changes are saved and the first-time enrollment conversation plays again the next time that they log 
on to Connection.

The “Enrolling as a Cisco Unity Connection User” chapter of the User Guide for the Cisco Unity 
Connection Phone Interface details the tasks that users are asked to complete as part of enrollment.

Explain How Connection Features and Functionality Work

12. Provide training on how to personalize user settings by using the phone and the Cisco Unity 
Assistant, as summarized in Table 4-1. In particular, users may benefit from a hands-on 
demonstration of the Cisco Unity Assistant, as they may not be accustomed to using a web interface 
to set voice messaging options.
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13. Provide training on how to use the Cisco Unity Personal Call Transfer Rules web tool, and how call 
transfers, call holding and screening, and caller options are used, as summarized in Table 4-2.

Users can refer to the User Guide for the Cisco Unity Connection Personal Call Transfer Rules Web 
Tool or to Cisco Unity Personal Call Transfer Rules Help for further guidance after orientation.

14. Explain how full mailboxes work with Connection. See the “Support Desk Orientation” section on 
page 5-2 for issues that users may encounter. Refer users to the appropriate user guides for similar 
information.

15. If your organization has users who will use RSS readers to access voice messages, provide training 
on using RSS with Connection. See the “Configuring Access to RSS Feeds of Voice Messages” 
section in the “Messaging” chapter of the System Administration Guide for Cisco Unity Connection 
for details.

16. If your organization has users who will use TTY and the TTY prompt set, provide training on using 
TTY with Connection.

17. Make sure that users who own call handlers or system distribution lists understand their 
responsibilities (if applicable).

18. As applicable, tell users how to use the Cisco Unity Greetings Administrator and System Broadcast 
Administrator.

Settings That Users Can Change
Revised May 2009
See the following tables:

 • Settings That Users Can Change By Using the Cisco Unity Assistant and the Phone Menus

 • Settings That Users Can Change By Using the Cisco Unity Personal Call Transfer Rules Web Tool 
and the Phone Menus

Table 4-1 Settings That Users Can Change By Using the Cisco Unity Assistant and the Phone Menus 

Settings That Can Be Changed by Using the Cisco Unity 
Assistant Settings That Can Be Changed by Using the Phone Menus

Call Holding and Screening1:

 • Select how Connection handles indirect calls when 
the user phone is busy, including placing the caller on 
hold, prompting the caller to hold or leave a message, 
and sending the caller directly to the greeting

 • Select how Connection handles indirect calls, 
including telling the user who the call is for, 
announcing that Connection is transferring the call, 
prompting the user to accept or refuse a call, and 
prompting callers to say their names

Call Holding and Screening1:

 • None
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Call Transfers2:

 • Configure the three basic transfer rules: standard, 
alternate, and closed hours

 • Enable or disable personal call transfer rules for each 
of the basic transfer rules

 • Transfer indirect calls to an extension or send them to 
the user greeting

 • Change extensions

Call Transfers2:

 • Configure the three basic transfer rules: standard, alternate, 
and closed hours

 • Enable or disable personal call transfer rules for each of the 
basic transfer rules

 • Transfer indirect calls to an extension or send them to the 
user greeting

 • Change extensions

 • Configure alternate contact numbers for caller input keys 
that are assigned to the Transfer to Alternate Contact 
Number action

Caller Options:

 • Allow callers to edit messages

 • Allow callers to mark messages urgent

Caller Options:

 • None

Phone Menu Options:

 • Set language for Connection prompts

 • Specify whether users use the phone keypad or 
voice-recognition input style

 • Set speed and volume of prompts, recorded names, 
and user greetings

 • Select full or brief Connection conversation menus

 • Select the action that Connection performs when the 
user calls Connection, including greeting the user by 
name, and announcing the number of new messages 
by type

 • Specify alternate extensions

Phone Menu Options:

 • Select full or brief Connection conversation menus

Greetings:

 • Record a personal greeting

 • Enable or disable greeting

 • Specify an expiration date for an enabled greeting

 • Switch between system prompt and personal greeting

Greetings:

 • Record a personal greeting

 • Enable or disable greeting

 • Specify an expiration date for an enabled greeting

Table 4-1 Settings That Users Can Change By Using the Cisco Unity Assistant and the Phone Menus (continued)

Settings That Can Be Changed by Using the Cisco Unity 
Assistant Settings That Can Be Changed by Using the Phone Menus
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Message Notification:

 • Enable or disable a notification device

 • Specify dialing or recipient options

 • Select the types of messages and message urgency for 
which Connection generates a notification

 • Specify a list of message senders (by user name or 
calling phone number) for which Connection 
generates a notification

 • Set up a notification schedule, and specify what 
happens when a device does not answer, is busy, or 
fails

Message Notification:

 • Enable or disable a notification device, and change its 
number

Message Playback:

 • Specify the speed and volume of messages that are 
played by phone

 • Specify message playback order

 • Change the time format used for message time stamps

 • Specify whether Connection plays the Message Type 
menu

 • Select the action that Connection performs when 
messages are played, including announcing the name 
and number of the sender who left a message, and 
whether the timestamp is played before or after the 
message

 • Specify that messages are marked saved upon 
hang-up or disconnect

 • Specify whether Connection asks to confirm deletions 
of new and saved messages

Message Playback:

 • Speed and volume of message as it is played

Message Sending and Addressing:

 • Specify that Connection prompts to confirm message 
recipients by name

 • Specify that Connection prompts to continue adding 
names after each recipient

 • Specify that Connection sends messages when users 
hang up or a call is disconnected

 • Switch between addressing messages to other users 
by name, or by extension

 • Specify order for addressing messages by name (last 
name then first name, or vice versa)

Message Addressing:

 • Switch between addressing to other users by name or by 
extension (by pressing ##)3

 • Review, add, or remove names in the addressing priority list4

Table 4-1 Settings That Users Can Change By Using the Cisco Unity Assistant and the Phone Menus (continued)

Settings That Can Be Changed by Using the Cisco Unity 
Assistant Settings That Can Be Changed by Using the Phone Menus
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Personal Settings:

 • Record a name

 • Specify alternate names

 • Change directory listing status

 • Change password

Personal Settings:

 • Record a name

 • Change directory listing status

 • Change password

 • Edit alternate contact numbers, if an administrator has 
configured one or more caller input keys to transfer to an 
alternate contact number during the user greeting

Private Lists:

 • Enter a display name

 • Record a list name

 • Add and delete members

Private Lists:

 • Record a list name

 • Add and delete members

Personal Contacts:

 • Set up an address book of personal contacts to use for 
both name dialing and call transfer rules

Personal Contacts:

 • None

1. Call holding and screening options apply only to incoming calls that were routed to the user from the automated attendant or a directory handler, and not 
on direct calls. Holding and screening options do not apply when an outside caller or another user dials a user extension directly. In addition, holding and 
screening options are only available when supervised transfers are enabled. These settings apply if the user does not have personal call transfer rules 
enabled.

2. Call transfer options apply only to incoming calls that were routed to the user from the automated attendant or a directory handler, and not on direct calls. 
Transfer options do not apply when an outside caller or another user dials a user extension directly.

3. Note that this depends on whether you have enabled spelled name addressing.

4. To enable users to access the setup conversation that allows them to review, add, or remove names in the addressing priority list, the users must be 
assigned to a custom conversation, and you must use the Custom Keypad Mapping tool to map the Addressing Priority List conversation to a key in the 
Message Settings menu for that conversation.

Table 4-2 Settings That Users Can Change By Using the Cisco Unity Personal Call Transfer Rules Web Tool and the 

Phone Menus 

Settings That Can Be Changed by Using the Cisco Unity 
Personal Call Transfer Rules Web Tool Settings That Can Be Changed by Using the Phone Menus

Call Holding and Screening:

 • Set up personal call transfer rules to specify how 
Connection handles direct and indirect calls when the 
user phone is busy, including placing the caller on 
hold, prompting the caller to hold or leave a message, 
and sending the caller directly to the greeting

 • Set up personal call transfer rules to specify how 
Connection handles direct and indirect calls, 
including telling the user who the call is for, 
announcing that Connection is transferring the call, 
prompting the user to accept or refuse a call, and 
prompting callers to say their names

Call Holding and Screening:

 • None

Table 4-1 Settings That Users Can Change By Using the Cisco Unity Assistant and the Phone Menus (continued)

Settings That Can Be Changed by Using the Cisco Unity 
Assistant Settings That Can Be Changed by Using the Phone Menus
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Call Transfers:

 • Set up personal call transfer rules to transfer direct 
and indirect calls to an extension, to an external phone 
number, or to the greeting

Call Transfers:

 • Enable or disable personal call transfer rules to transfer 
direct or indirect calls to an extension, to an external phone 
number, or to the greeting

 • Enable or disable the Transfer All rule set to forward all calls 
to voice mail or to another phone number

 • Forward all incoming calls directly to Connection, rather 
than to phone extension

Caller Options:

 • Allow callers to edit messages

 • Allow callers to mark messages urgent

Caller Options:

 • None

Destinations:

 • Set up phone numbers or notification devices to use 
when transferring calls

 • Set up groups of destinations to use in personal call 
transfer rules

 • Specify the number of rings that Connection waits 
before transferring the call to the next destination or 
to voice mail

Destinations:

 • None

Caller Groups

 • Create groups of personal contacts, system contacts, 
or Connection users to use in personal call transfer 
rules

Caller Groups

 • None

Table 4-2 Settings That Users Can Change By Using the Cisco Unity Personal Call Transfer Rules Web Tool and the 

Phone Menus (continued)

Settings That Can Be Changed by Using the Cisco Unity 
Personal Call Transfer Rules Web Tool Settings That Can Be Changed by Using the Phone Menus
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Operator and Support Desk Orientation

Operators in your organization need information about Cisco Unity Connection that is specific to your 
installation. In addition, if your organization has a support desk, the staff need to be prepared to answer 
the questions that users may ask, and to be aware of the resources that are available to assist them in 
answering user questions.

See the following sections:

 • Operator Orientation, page 5-1

 • Support Desk Orientation, page 5-2

Operator Orientation
Operator orientation should address the same points as user orientation, but in greater detail. Operators 
must be familiar with how users use Cisco Unity Connection. Depending on the size of your 
organization, the operator may be the person users are likely to ask when they have questions about 
Connection.

In addition to the information in the “User Orientation” chapter and the “Support Desk Orientation” 
section on page 5-2 (as applicable), operators also need to understand the following concepts and tasks.

Roles of the Operator and the Automated Attendant

The way your organization uses the automated attendant determines what the operator responsibilities 
are. The automated attendant is a call handler that is used in place of a human operator to answer and 
direct calls by playing greetings and responding to caller input. The automated attendant can provide a 
menu of options (for example, “For Sales, press 1; for Service, press 2.”), and it can also provide 
information (for example, “Our normal business hours are Monday through Friday, 8 a.m. to 5 p.m.”).

Directing Calls

Regardless of how your organization uses the automated attendant, many calls go to the operator. The 
operator must know how to direct calls to voice mail and to user phones. With Cisco Unified 
Communications Manager (CM) (formerly known as Cisco Unified CallManager), you can program the 
phone to direct calls to voice mail. For details on setting this up, see the tech note How to Transfer a 
Caller Directly into a Cisco Unity Mailbox, available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_tech_notes_list.html.

Forwarding Messages to Intended Recipients

If an operator also owns a call handler or system distribution list, make sure that the operator knows to 
review messages frequently, and to forward messages as necessary to the applicable recipients.
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Using the Cisco Unity Greetings Administrator

An operator who is responsible for changing call handler greetings for the organization can use the 
Cisco Unity Greetings Administrator when it is not practical to change a greeting in Cisco Unity 
Connection Administration. For example, if the office is unexpectedly closed because of bad weather, 
the operator can call from home to use the Cisco Unity Greetings Administrator to enable the alternate 
Opening Greeting, or to rerecord a call handler greeting stating that the office is closed. See the “Using 
the Cisco Unity Greetings Administrator to Record or Rerecord Call Handler Greetings” section in the 
“Managing Recorded Greetings and Recorded Names” chapter of the System Administration Guide for 
Cisco Unity Connection for instructions.

Using the Cisco Unity Broadcast Message Administrator

If an operator is responsible for sending recorded announcements to everyone in an organization (or to 
particular locations within an organization), explain how to access and use the Cisco Unity Broadcast 
Message Administrator to send broadcast messages. See the “Setting Up Broadcast Messaging” chapter 
of the System Administration Guide for Cisco Unity Connection for instructions.

Support Desk Orientation
Support desk orientation should address the same points as user and operator orientation, but in greater 
detail. Support desk staff must be familiar with how users and operators use Cisco Unity Connection, 
and the common problems that users may encounter when using Connection. Instead of using the 
Connection server, it may be helpful to set up a test server that support desk staff can use to browse to 
Cisco Unity Connection Administration, and troubleshoot and test client applications.

To prepare for possible calls to the support desk at your organization, familiarize the support desk staff 
with the resources listed in the following “Support Desk Resources” section, and with the potential user 
concerns and misconceptions listed in the “Potential User Concerns and Misconceptions” section on 
page 5-3. (See also the“Operator Orientation” section on page 5-1 and the “User Orientation” chapter.)

Support Desk Resources
 • User documentation is available at 

http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.

 • The Compatibility Matrix: Cisco Unity Connection and the Software on User Workstations is 
available at 
http://www.cisco.com/en/US/products/ps6509/products_device_support_tables_list.html.

 • The following chapters in this guide provide information on how user workstations should be set up, 
and describes how users use Connection client applications:

 – Setting Up Access to the Cisco Personal Communications Assistant

 – Setting Up Playback and Recording Devices for the Media Master

 – Configuring an Email Account to Access Cisco Unity Connection Voice Messages

 • The Troubleshooting Guide for Cisco Unity Connection is available at 
http://www.cisco.com/en/US/products/ps6509/prod_troubleshooting_guides_list.html.

 • For descriptions and the URLs of all Connection documentation on Cisco.com, see the 
Documentation Guide for Cisco Unity Connection. The document is shipped with Connection and 
is available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/roadmap/7xcucdg.html.
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Revised May 2009
Table 5-1 describes potential user issues, which are typically based on misconceptions about how 
Cisco Unity Connection works. Users who encounter such issues are often those who are accustomed to 
another voice messaging system, have not yet completed Connection training, or are unaware of a new 
feature or functionality change to an existing system.

Table 5-1 Potential User Concerns and Misconceptions 

Potential Issue Description

Delayed messages Users may believe that their messages are delayed for the following reasons:

 • While listening to new messages, users may skip a message and inadvertently mark it new. 
Later, when they check messages again, they hear the skipped message and believe that the 
message arrived after a delay.

 • Users may skip more messages than they intend while listening to their messages, and later 
check messages again only to hear one or more of the skipped messages, and believe that the 
messages arrived after a delay.

 • While listening to messages, other new messages arrive that users may not be aware of. Later, 
when they check messages again, they hear the new messages and believe that they were 
delayed.

Deleted messages By default, when users delete a new or saved message, Cisco Unity Connection does not ask them 
to confirm the deletion. You may want to enable Connection to request confirmation from users 
before proceeding with the deletion, especially if many users do not belong to a class of service that 
allows them to retain and review their deleted messages. You can set up Connection to confirm 
deletion of messages on the System Settings > Advanced > Conversations page in Cisco Unity 
Connection Administration.

For information on deleted messages, refer users to the “Deleting Messages” chapter of the User 
Guide for the Cisco Unity Connection Phone Interface, available at 
http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.
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Deleted messages: 
IMAP and MAPI 
behavior

When users access messages stored on a Microsoft Exchange server both from a Microsoft Outlook 
client and from Cisco Unity Connection, they may experience unexpected and confusing behavior 
when deleting messages. The difference in behavior occurs when the Microsoft Outlook client is 
configured to use MAPI, the Microsoft interface for connecting to Exchange, and stems from the 
fact that MAPI and IMAP—the protocol used by Connection—use different mechanisms for 
marking messages as deleted.

If you have users who access a Microsoft Exchange server by using Outlook (with MAPI) or 
Outlook Web Access, and who also use Connection to manage messages on the same message store, 
be sure to alert them to this behavior.

Deleted Messages—IMAP Behavior

When a user deletes a message from Microsoft Outlook, the message is moved from the Inbox to 
the Deleted Items folder. At this point, Connection can no longer access the message, and no longer 
indicates that the message exists either as a new, saved, or deleted message.

Deleted Messages—MAPI Behavior

When a user deletes a message from Connection, the message remains in the Inbox but is flagged 
to indicate that it has been marked deleted by the user. However, when configured to use MAPI, 
Microsoft Outlook does not recognize this flag as a deletion, and continues to display the message 
as a new or saved message in the Inbox.

Directory listing: users 
are not listed as 
expected

When users do not have a recorded name, they are not listed in the phone directory and as a result, 
outside callers are not be able to find them when searching for them by name. By default, 
Cisco Unity Connection prompts users to record a name during first-time enrollment, but it does 
not prevent them from completing the enrollment process if they do not.

To address this issue, consider the following options:

 • You can change whether recording a name is required to complete first-time enrollment on the 
System Settings > Advanced > Conversations page in Cisco Unity Connection Administration.

 • You can provide recorded names for users in Cisco Unity Connection Administration.

 • Users with class of service rights can record their own names by using the Connection 
conversation or the Cisco Unity Assistant.

Note This problem does not occur for internal users, but only for outside callers; Connection 
users who address messages by name are still able to find other users even if they have not 
recorded a voice name.

Fax: attached files are 
not delivered to fax 
machines

(fax integrations only)

Users may be unaware that when they add attachments to an email message and then send the 
message to a fax machine, Connection renders only those attachments with the file extensions 
specified during Connection setup. All other attachments are removed.
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IMAP client: 
Differences in client 
behavior

Users who use different third-party IMAP clients to access voice messages from their desktop 
machines may note the following discrepancies in behavior:

 • Microsoft Outlook client:

 – For new messages, the “Mark as Unread” feature marks messages as new on the 
Cisco Unity Connection server, regardless of whether the WAV file message attachment is 
downloaded or not.

 – Voice messages that are deleted by phone are marked for deletion in the Outlook client and 
are changed to strikethrough text when users select the “Send/Receive” command.

 • Novell GroupWise client:

 – When new messages with the WAV file message attachment have been downloaded to the 
GroupWise client, the “Read Later” feature no longer marks the message as new on the 
Connection server.

 – Voice messages that are deleted by phone are not marked for deletion in GroupWise; users 
need to manually delete them from this client.

 – GroupWise users need to use the “Send/Retrieve” command to update message status from 
the Connection server.

Mailbox fills up quickly Users may complain that their mailboxes are filling up too quickly, for any of the following reasons:

 • Cisco Unity Connection does not automatically delete messages when they reach a certain age. 
This means that user messages are saved until the user deletes them permanently. (For 
information on how to permanently delete messages, refer users to the “Managing the Size of 
Your Mailbox” chapter of the applicable user guides available at 
http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.)

 • When users receive nondelivery receipts (NDRs) to messages that they send, their email client 
mailbox can quickly increase in size—especially if the original message included large 
attachments. For users who have access to email messages via TTS, if their email clients are 
configured to save their sent messages, the original message and attachments are stored in their 
Sent Items folders and another copy is sent to their Inboxes along with the NDR, increasing 
their mailbox size accordingly.

 • Users may receive messages that have been forwarded many times over, which increases 
message size. The original message plus all recorded introductions that were added during 
forwarding equal the total message size. As a result, users who have relatively few messages 
stored in their mailboxes may still find that their mailboxes exceed the storage limits.

 • User mailboxes can fill up while users are on vacation or on an extended leave of absence. To 
prevent this, specify that Connection prevents callers from leaving messages when users have 
their alternate greetings enabled.

Table 5-1 Potential User Concerns and Misconceptions (continued)
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Managing multiple 
message types

Users who are new to Cisco Unity Connection sometimes have a difficult time understanding how 
to manage multiple message types from a single Inbox. 

Depending on your system configuration:

 • Users with voice mail access can customize the order in which messages are played for new, 
saved, and deleted messages.

 • Users who have set up an IMAP client application to access voice messages may want to create 
a folder in their email client to store voice messages separately from other messages.

Users can also use the Save Recording As option available from the Options menu on the Media 
Master to save voice messages as WAV files on their hard drives. Note, however, that private 
messages cannot be saved to the user hard drive. In addition, you can prohibit users from saving any 
messages to their hard drives, regardless of message sensitivity, by checking the Unity Inbox: 
Disable Save Recording As Option in Media Master check box on the System Settings > 
Advanced > PCA page in Cisco Unity Connection Administration.

Message notification: 
repeat notification 
options

When a user chooses not to have Cisco Unity Connection restart notification each time a new 
message arrives, setting a long interval between repeat notification calls may lead the user to believe 
that Connection is delaying notification.

Media Master: opening 
a file that is saved on a 
workstation

When a user attempts to use a previously recorded WAV file (for example, an announcement that 
was recorded earlier) rather than recording by using a phone or a computer microphone, the Media 
Master may display an error message. The error occurs when the WAV file was recorded in the 
G.729a audio format. To resolve the problem, the user must do one of the following:

 • Convert the WAV file to another audio format (for example, convert it to the G.711 audio 
format).

 • Use a WAV file that is recorded in a supported audio format other than G.729a.

 • Make the recording by using a phone or a computer microphone.

MWIs To gain an understanding of when MWIs turn on and off, what causes them to turn on and off, and 
what causes MWIs to behave differently than expected, see the “Message Waiting Indicators 
(MWIs)” chapter of the Troubleshooting Guide for Cisco Unity Connection Release 7.x.

Passwords are not 
secure, or users use the 
wrong password

Users may assume that their phone and Cisco Personal Communications Assistant (PCA) 
passwords are the same or are synchronized. As a result, they may think that they are changing both 
passwords when Cisco Unity Connection prompts them to change their phone password during 
first-time enrollment. Additionally, they may try to use their phone password to log on to the 
Cisco PCA.

Table 5-1 Potential User Concerns and Misconceptions (continued)
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Speed for elements of 
the Connection 
conversation varies

Users may report that the speed at which Cisco Unity Connection plays menus, recorded names, 
greetings, and messages is inconsistent. For example, users may report that when they listen to their 
messages, the message is played at a different speed than the recorded names of users who leave 
them messages and the message properties (for example, the timestamp and message number).

Such inconsistencies are expected when you consider the following:

 • Connection plays recorded names and greetings at the speed at which they were recorded. 
Neither you nor users can affect the playback speed of recorded names and greetings.

 • Messages played via Text to Speech (TTS) are always played at normal speed by default, 
regardless of message playback settings.

 • The speed that you or a user specifies for system prompts—the standard recordings that come 
with the Connection system, including prompts for message properties—does not affect the 
playback speed of messages.

 • The speed that users specify for message playback does not affect system prompts.

Unread messages Depending on how Cisco Unity Connection is set up at your organization, users may be surprised 
at how Connection handles messages when calls are intentionally or unintentionally disconnected 
(for example, when a user hangs up or when a cell phone loses its charge or signal) while users are 
in the process of listening to new messages. Some users may incorrectly assume that Connection 
marks the message as read, which is not the case.

You can change how Connection handles unread messages when calls are disconnected by adjusting 
the “Mark Message Saved If User Hangs Up” setting on the System Settings > Advanced > 
Conversations page of Cisco Unity Connection Administration.

Unsent messages Depending on how Cisco Unity Connection is set up at your organization, users may be surprised 
at how Connection handles messages when calls are intentionally or unintentionally disconnected 
(for example, when a user hangs up or when a cell phone loses its charge or signal) while users are 
in the process of sending, replying to, or forwarding a message. Some users may incorrectly assume 
that Connection offers a draft folder for unsent messages, which is not the case.

You can change how Connection handles unsent messages when calls are disconnected by adjusting 
the “Send Message If User Hangs Up During Recording” setting on the System Settings > 
Advanced > Conversations page of Cisco Unity Connection Administration.
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